
 Avid® Editing Application
ReadMe for Media Composer® v6.0.1, NewsCutter® v10.0.1, 
and Symphony™ v6.0.1

IMPORTANT: Avid periodically makes software updates available for download on 
Avid.com at the following location:www.avid.com/us/support/downloads. Please 
check the above site regularly for information on available downloads for your 
product.

Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before 
installing or using any new software release. 

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which 
contains the latest information that might have become available after the documentation was 
published.

This document describes compatibility issues with previous releases, software installation 
instructions, hardware and software requirements, and summary information on system and 
memory requirements. This document also lists hardware and software limitations.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.
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If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the 
documentation was published. Also check online for the most up-to-date ReadMe because 
the online version is updated whenever new information becomes available. To view the 
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at 
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues. In addition to the printed documentation supplied 
with your editing application, the documentation is supplied in PDF format when you install 
the application. Topics that you print from the Help have limited page layout and formatting 
features. If you want to print a higher quality version of Help information, Avid recommends 
that you print all or part of the PDF version of the appropriate Avid manual included in the 
Online Library for your editing application. To access the Online Library, select Help > 
Online Library from within your Avid editing application. 

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24 
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error 
messages, to access troubleshooting tips, to download updates, and to read or join online 
message-board discussions.

Fixed in Media Composer v6.0.1, Symphony v6.0.1, 
and NewsCutter v10.0.1

The following were fixed in this release of the editing application.

➤ Bug Number: UDevC00167089. Bin layouts might not have saved correctly.

➤ Bug Number: UDevC00166739. Occasionally, the editing application would crash when 
quitting the application.

➤ Bug Number: UDevC00166670. You might have received an error when reopening the Media 
Tool if you had not closed the Media Tool before exiting a project.

➤ Bug Number: UDevC00163566. You might have received an “Asserting_Name_Max_Len” 
error when typing more than 27 symbols in a Japanese locale.

http://www.avid.com/readme
http://www.avid.com/onlinesupport
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➤ Bug Number: UDevC00165571. (Macintosh) The keyboard settings were not mapping properly 
with foreign keyboards. 

➤ Bug Number: UDevC00166734. You might have received an Assertion error after performing 
an auto correction when in Color Correction mode. 

➤ Bug Number: UDevC00166524. You might have received a “Runtime” error when dragging a 
closed bin from the Project window to an opened bin window. 

➤ Bug Number: UDevC00166305. When in Color Correction mode, the parameter sliders did not 
display properly. 

➤ Bug Number: UDevC00166628. If you used the tab key to navigate through the workspaces 
dropdown menu, you might have received a Segmentation fault error. 

➤ Bug Number: UDevC00155359. Attic files were not being deleted after the maximum number 
of files was reached. The maximum attic files number is set in the Bin Settings window. If you 
have a project attic that is over the maximum setting by a small number of files, the next time 
you perform a save after installing this patch, the excess attic files will be deleted (oldest files 
first) and a thermometer will appear showing the deletion progress.

If you have a project attic that is significantly over the maximum files setting, the next time your 
perform a save after installing this patch, the editing application will rename the existing project 
attic with a “__OLD” name and a new project attic will be created. A dialog will be displayed 
stating that the attic has been renamed and lists the path to the renamed folder. Customers are 
responsible for verifying the contents of the “__OLD” attic folder and for deleting it to free up 
disk space. The newly created project attic will adhere to the maximum setting in the Bin 
Settings window. The settings affect the file count for project-level attics. The overall Avid Attic 
can be significantly higher, depending on the number of projects stored on the system.

Note that these settings are per project and not for the entire attic folder. The entire Attic folder 
has multiple projects.

Option Description

Maximum files in a 
project’s attic

Defines the maximum number of files stored in the Avid Attic folder for each project. 
When a bin or script is saved, your Avid editing application copies the current version of 
the bin or script to a subfolder within the special folder called the Avid Attic. Each project 
has its own subfolder and each bin or script saved in a project has its own subfolder within 
the project folder. The default is 1000 files per project. The overall file count for the entire 
Avid Attic will reflect the files stored for each project on the system.
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➤ Bug Number: UDevC00165318. When loading an Omneon MXF file, you might have received 
a PMM_MISMATCH_AUDIO_FORMAT error. Update to the latest MXF AMA plugin.

➤ Bug Number: UDevC00165978. You could not enter pan values in the pan value field in the 
Audio Mixer tool. 

➤ Bug Number: UDevC00165149. (Windows) The infinity dB symbol in the Audio Mixer tool 
displayed as a square.

➤ Bug Number: UDevC00166126. You can now move a folder into another folder when in the 
Project Window.

➤ Bug Number: UDevC00149254. Performing a drag and drop from a bin to the desktop did not 
work. This has been fixed for Windows systems.

➤ Bug Number: UDevC00165182. (Macintosh) The spacing between text characters (kerning) 
was not consistently readable throughout the user interface. 

➤ Bug Number: UDevC00164726. You might have received a “WM_WRITE_SAMPLE_Failed” 
error when exporting Windows Media (.wmv) files.

➤ Bug Number: UDevC00165107. (XDCAM) You might have received a “freed object” error 
when modifying AMA resolutions on a sequence with multiple cuts from the same clip.

➤ Bug Number: UDevC00162897. An “unable to locate the web document” error would occur 
when saving a FilmScribe review when using the Japanese locale. 

➤ Bug Number: UDevC00162886. The EDL Manager Get and Send buttons were not selectable 
when the editing application was running.

➤ Bug Number: UDevC00165599. The right border of the EQ graph would disappear after a 
redraw. 

➤ Bug Number: UDevC00165552. Choosing Reverse Selection from the bin Fast menu, did not 
reverse the selection. 

Max versions of a 
file in the attic

Defines the maximum number of single-bin or script copies stored in a project's attic. This 
setting prevents filling the project's attic with too many versions of one bin or script. The 
default is 50 versions.

Option Description
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➤ Bug Number: UDevC00165844. (Nitris DX or Mojo DX) You might have received a 
“NEMFileWriter Timeout” error when transcoding 1:1 or 1:1 10bit to DNxHD. 

➤ Bug Number: UDevC00165502. Fast importing QuickTime movies with Alpha to OMF 
produced artifacts when in an SD project.

➤ Bug Number: UDevC00165300. Importing graphics or QuickTime movies to 1:1 10bit 
resolution was not working properly.

➤ Bug Number: UDevC00165108. (Macintosh) With dual monitors and the Macintosh menu bar 
located on the right hand monitor, accessing and saving workspaces did not work properly. Some 
windows were drawn off screen. 

➤ Bug Number: UDevC00163793. In a MediaNetwork environment, increasing the number of 
mounted workspaces caused the editing application to slow down. 

➤ Bug Number: UDevC00165600. After applying a video or audio effect, opening the Effect 
editor window might have resulted in an Access violation error.

➤ Bug Number: UDevC00165460. Disabling the “Enable Confidence View” option in the Video 
Display Settings and then selecting the V track in the Capture Tool might have resulted in an 
Assertion error.

➤ Bug Number: UDevC00165221. Playing a 3D clip in source color correction mode might have 
caused “Consistency Check Failure” errors.

➤ Bug Number: UDevC00165305. (Windows) After installing MediaLog, the application would 
not launch unless the DVD installer was in the tray. The MediaLog installer now requires a 
reboot after install which fixes the issue.

➤ Bug Number: UDevC00165320. The Composer Window did not minimize and then maximize 
properly. 

➤ Bug Number: UDevC00165795. Switching between bin layouts might have resulted in an 
Assertion error. 

➤ Bug Number: UDevC00165461. Maximizing the editing application and then importing and 
deleting a clip might have put the editing application into an unusable state. 

➤ Bug Number: UDevC00165429. (Macintosh) You might have received a “Segmentation fault” 
error after switching from a stereoscopic format and adding an effect to a clip that had removed a 
color correction effect.
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➤ Bug Number: UDevC00165418. On some systems, when in trim mode, dragging the trim 
rollers right and left did not update in the monitors.

➤ Bug Number: UDevC00165262. Occasionally the system would crash if you were in a 
stereoscopic project and you entered source side Color Correction mode.

➤ Bug Number: UDevC00165306. The Assemble Edit button now appears red when selected.

➤ Bug Number: UDevC00165113. (Windows) You could not correctly resize the Composer 
window when using two monitors. 

➤ Bug Number: UDevC00165084. (Macintosh) You could not resize a newly created bin window. 

➤ Bug Number: UDevC00165398. Selecting “Loop selected clips” from the bin Fast menu did 
not function properly. 

➤ Bug Number: UDevC00164508. Double-clicking text such as sequence and clip names did not 
highlight the text.

➤ Bug Number: UDevC00164402. (Windows) The Composer window would decrease in size 
when you clicked the maximize button.

➤ Bug Number: UDevC00163709. You might have seen redraw issues when importing. 

➤ Bug Number: UDevC00165295. Previously, after creating a new user and new project, then 
opening the Audio Mixer tool, the title bar of the Audio Mixer tool would open under the 
topmost file menu.

➤ Bug Number: UDevC00164886. The text in the Comments field in Script view was corrupt.

➤ Bug Number: UDevC00162559. (Macintosh) The Command +’ shortcut now works properly. 

➤ Bug Number: UDevC00161169. Moving the Clip high and Clip Low controls (in the Color 
Correction HSL tab) left artifacts in the User Interface. 

➤ Bug Number: UDevC00165271. The Nitris DX hardware has only 8 channels of high quality 
capture sample rate conversion. Previously, when you captured more than 8 channels of audio 
when connected to Nitris DX, the sample rate conversion would apply to 8 channels of audio and 
the other captured channels might result in static. Now if you capture 12 or 16 channel audio 
from HD-SDI, the editing application requires the sample rate to be 48K, disallowing sample 
rate conversion.
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➤ Bug Number: UDevC00164765. (Windows) When you held down the ALT key while opening a 
project, the project window opened as its own application. 

➤ Bug Number: UDevC00165233. Rolling or crawling titles are now supported with ProRes SD. 

➤ Bug Number: UDevC00165371. When recreating title media, the bin size would grow much 
larger than with previous releases.

➤ Bug Number: UDevC00165315. When performing a batch capture, corrupt media files might 
have been created if you selected “Optimize for batch capture.”

➤ Bug Number: UDevC00165583. Japanese dialog boxes might have displayed incorrect 
characters.

➤ Bug Number: UDevC00165419. Clicking on the source side track panel with the source 
monitor active, activated the record monitor. The source monitor now remains active.

➤ Bug Number: UDevC00162296. (Nitris DX) You might have seen a frame reordering after 
performing a video mixdown with XDCAM EX material.

New in Media Composer v6.0, Symphony v6.0, and 
NewsCutter v10.0

For information on new features, see the What’s New pdf. 

AMA Plug-ins

Just a reminder that only the AMA QuickTime Plug-in is included with your Avid editing 
application. All other AMA Plug-ins are downloaded and installed separately. See 
www.ama.com.

Before Installing the Editing Application

Read through the Installation Guide for Avid Editing Applications. This document ships with the 
editing application kit. If you did not receive a physical kit, this document is also on the 
download page and the Knowledge Base.

http://www.avid.com/US/products/Avid-Media-Access
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Notes on MacIntosh Snow Leopard OS

The Avid editing application Macintosh installer switches to 64-bit. Please make sure that your 
Macintosh Lion v10.7 system supports 64-bit prior to installing and that your current non-Avid 
applications are compatible to run in 64-bit mode.

Notes on Windows 7 OS

Note the following topics if you are running the editing application on the Windows 7 OS.

Disabling Desktop Compositing

When the Avid editor is launched you might see a dialog box asking you to disable desktop 
compositing. You can disable it without adversely affecting the Avid editing application.

You can choose to disable it and continue with your editing session. The dialog will appear once 
you relaunch the application unless you disable the option.

To disable the desktop compositing:

1. Access the Control Panel.

2. Double-click System.

3. Click Change Settings.

4. Click the Advanced tab.

5. Under the Performance area, click Settings.

6. Uncheck “Enable desktop composition.”

The dialog box requesting you to disable desktop compositing does not appear the next time 
you launch the editing application.

Standard User

You need to first install the editing application as an Administrator. If you are in a Shared 
Storage environment, mount your workspaces as an Administrator. You may then log off and log 
back in as a Standard user, if necessary.
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Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first 
deactivate your software. After you upgrade your operating system and, if required, reinstall 
your application, you can reactivate your software. For information on activating and 
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends a minimum of 4GB of RAM. Some features might require 
more RAM and specific hardware. See “Feature Performance” on page 23 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance” 
on page 23 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware. 
The following tables also list the qualified Operating Systems. Depending upon your hardware 
the qualified Operating Systems are:

• Windows 7 64-bit SP1(Professional)

• (Media Composer and Symphony) Macintosh Lion v10.7.1 and v10.7.2

Lion Permission Information

As of Macintosh OS 10.7 Lion, the default permissions for the root level of the system drive are 
now set to “Read Only” for all users. This prevents the Avid Editing Application from being able 
to use this drive as a media drive. You will see the drive grayed out in Media Creation settings or 
as an option for import, mixdown, render, and consolidate/transcode.

If you don’t intend to use the system drive for media you can leave it alone. This is ideal in most 
cases.

If you do need to use the system drive, perform the following to change permissions.
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To change permissions:

1. Click on your system drive (Macintosh HD in most cases) to highlight.

2. From the File menu select Get Info (cmd+I)

3. Click the lock icon in the bottom right to make changes

4. Click on the “Read only” text in the Privilege column next to Everyone and set the privilege 
to “Read & Write”

You should now be able to see the system drive as a valid media drive.

n If you repair permissions on the system drive, they will reset and you will have to repeat this 
procedure.

Qualified PC Workstations with Avid Media Composer, Avid Symphony, 
and Avid NewsCutter

The following PC Workstations are qualified with Avid Media Composer v6 and higher, Avid 
Symphony v6 and higher and NewsCutter v10 and higher.

Qualified PC 
Hardware Graphics Card Qualified OS Supported with 

HP z800 Dual 6 Core, 
2.66 GHz 

NVIDIA
Quadro FX 3800
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z800 Dual Quad 
Core, 2.93 GHz or 
2.66GHz

NVIDIA
Quadro FX 3800
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z400 Single 6 Core 
3.33 GHz

NVIDIA 
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z400 Single Quad 
Core, 3.06 GHz or 2.93 
GHz

NVIDIA
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z210 Quad Core 
Xeon 3.3- E3-1240, 3.4 
E3-1270, 3.5 E3-1280

Quadro 600 Windows 7 64-bit Software Only

HP z200 Intel® Core™ 
i5-660 3.33 4MB/1333 
Dual-Core 

NVIDIA 
Quadro 600

Windows 7 64-bit Software Only
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Qualified PC Notebooks for Avid Media Composer, Avid Symphony, and 
Avid NewsCutter

The following PC Notebooks are qualified with Avid Media Composer v6 and higher, Avid 
Symphony v6 and higher and Avid NewsCutter v10 and higher. The following applies to the 
editing system when running on a laptop:

• DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading 
enabled. Nitris DX is not supported on laptops.

• Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.

• Playback in full quality 10 bit mode is not supported

Dell™ T5500 Dual 6 
Core, 2.66GHz 

NVIDIA
Quadro FX 4800
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T5500 Dual, 
2.93GHz Quad Core

NVIDIA 
Quadro FX 4800 
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T3500 Single 6 
Core, 3.2GHz 

NVIDIA 
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T3500 Single 
Quad Core, 2.93GHz 

NVIDIA
Quadro FX 3800 
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP xw8600 Dual Quad 
Core, 3.0 GHz

NVIDIA 
Quadro FX 3700 

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T5400 Dual Quad 
Core, 2.5 GHz or 3.15 
GHz

NVIDIA 
Quadro 3700

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP xw4600 Core 2 
Duo, 3.0 GHz 

NVIDIA
Quadro FX 570

Windows 7 64-bit Software Only

Dell T3400 Core 2 Duo, 
2.33GHz,or 2.66 GHz 

NVIDIA
Quadro FX 570

Windows 7 64-bit Software Only

Qualified PC 
Hardware Graphics Card Qualified OS Supported with 
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Qualified PC 
Notebooks Graphics Cards Qualified OS Supported With

HP 8760w i7-282Q, 
i7-2820Q 2.2 or 2.3 GHz

NVIDIA
Quadro 3000M
Quadro 4000M

Windows 7 64-bit Software Only
Mojo DX

HP 8560w, i7-2720Q, 
2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Windows 7 64-bit Software Only

Dell M6600, i7-2720Q, 
2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 3000M
Quadro 4000M

Windows 7 64-bit Software Only
Mojo DX

Dell 4600, i7-2720Q, 2820Q, 
2.2 or 2.3 GHz
15” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Windows 7 64-bit Software Only
Mojo DX

HP 8740w X820, X920 
Quad i7 (1.73, 2.0 GHz)

17" 1920x1200

NVIDIA FX
2800M

NVIDIA FX
3800M

Windows 7 64-bit Software Only
Mojo DX

HP 8540w X720, X820 
Quad i7 (1.6, 1.73 GHz)

15" 1920x1080

NVIDIA FX
1800M

Windows 7 64-bit Software Only
Mojo DX

Dell M6500 i- 820Q, 
i7-840Q, i7-920X(1.73, 1.87, 
2.0 GHz)

17" 1920x1200

NVIDIA FX
2800M

NVIDIA FX
3800M

Windows 7 64-bit Software Only
Mojo DX

HP 8730 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 2700M
Quadro FX 3700M

Windows 7 64-bit Software Only

HP 8530 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 770M

Windows 7 64-bit Software Only

Dell 6400 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 2700M
Quadro FX 3700M

Windows 7 64-bit Software Only
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Qualified Macintosh Workstations for Avid Media Composer and Avid 
Symphony

The following Macintosh Workstations are qualified with the Avid Media Composer v6 and Avid 
Symphony v6 and higher. Mac Pro systems ship with the 64-bit kernel enabled. In previous 
releases, you had to toggle to the 32-bit kernel. With v6 and higher, you must run with the 64-bit 
enabled.

Qualified Macintosh 
Hardware Graphics Cards Qualified OS Supported With

Mac Pro “Westmere” 
Two 2.66GHz 6-Core 
Intel Xeon (12 cores) 

ATI Radeon HD 5770 Lion v10.7.1 and 
v10.7.2

Software Only
Nitris DX
Mojo DX

Mac Pro “Nehalem” 
2.66 GHz or 2.93 GHz 
Dual Quad Core Intel 
Xeon 

NVIDIA GeForce 
GT 120

Lion v10.7.1 and 
v10.7.2

Software Only
Nitris DX
Mojo DX

Mac Pro “Nehalem” 
Dual 2.26 GHz Quad 
Core Intel

NVIDIA GeForce GT 
120

Lion v10.7.1 and 
v10.7.2

Software Only

Mac Pro “Harpertown” 
Dual Quad Core 3.0 or 
3.2 GHz

NVIDIA GeForce 
8800 GT

Lion v10.7.1 and 
v10.7.2

Software Only
Nitris DX
Mojo DX

iMac 27” Display Quad 
Core 3.4 GHz

ATI 6970M Lion v10.7.1 and 
v10.7.2

Software Only

iMac 27” Display Quad 
Core 2.93 GHz

ATI 4850 Lion v10.7.1 and 
v10.7.2

Software Only

iMac 21.5” Display 
Dual Core 3.6GHz

GeForce 9400 Lion v10.7.1 and 
v10.7.2

Software Only

iMac 27” Display 
2.8 GHz 4 GB Quad 
Core 1066MHz

ATI Radeon HD 4850 
Graphics Processor

Lion v10.7.1 and 
v10.7.2

Software Only

iMac 27” Display Quad 
Core 2.8GHz

ATI 4850 Lion v10.7.1 and 
v10.7.2

Software Only

iMac 20” Display 
2.66 GHz Core 2 Duo

GeForce 9400 Lion v10.7.1 and 
v10.7.2

Software Only

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
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Qualified Macintosh Notebooks for Media Composer and Avid Symphony

The following Macintosh notebooks are qualified with the current editing applications. The 
following applies to the editing system when running on a laptop.

• HD Capture on Macintosh notebooks is not supported

• Playback in full quality 10 bit mode is not supported

Qualified Macintosh 
Hardware Graphics Cards Qualified OS Supported With

Qualified Macintosh 
Notebook Graphics Cards Qualified OS Supported With

MacBook Air 13” 
1.7GHz Dual-Core Intel Core i5 
or 
1.8GHz Dual-Core Intel Core i7

Intel 
3000

Lion v10.7.1 and 
v10.7.2

Software Only

MacBook Pro 17" 
2.2/2.3/ GHz Quad Core i7

6750M
Intel 
3000

Lion v10.7.1 and 
v10.7.2

Software Only
Mojo DX (no DNxHD capture)

MacBook Pro 15" 
2.0/2.2/2.3GHz Quad Core i7

6490M
6750M
Intel 
3000

Lion v10.7.1 and 
v10.7.2

Software Only

MacBook Pro 15" 
2.53GHz Dual Core i5
15” or 17” 2.66GHz Dual Core i7

GT 330M Lion v10.7.1 and 
v10.7.2

Software Only
17” only - Mojo DX (no 
DNxHD capture)

MacBook Pro 15” or 17” 
2.53/2.66/2.8 GHz Core 2 Duo

 9400M and 9600M Lion v10.7.1 and 
v10.7.2

Software Only
Mojo DX (no DNxHD capture)

MacBook Pro 15” and 17” 
2.5 GHz Core 2 Duo 

 8600M Lion v10.7.1 and 
v10.7.2

Software Only
Mojo DX (no DNxHD capture)
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Compatibility Chart

The following table lists the operating system, NVIDIA® driver, QuickTime®, Windows Media™, 
Avid Interplay®, shared storage, Sony® XDCAM™, Panasonic® P2, and Pro Tools LE® versions 
that were qualified with the Avid editing applications. Also listed are the third-party applications 
such as Boris Continuum Complete, Avid DVD by Sonic™, and Sorenson Squeeze®that ship with 
the editing applications.

Item Versions Comments

QuickTime Support v7.7.1 (Windows)
v10 X (Macintosh)

Note: QuickTime v10X does not include 
QuickTime Pro options.

Windows Media 
Version Support

Windows Media Player 12 (for 
Windows 7)

If you do not have Windows Media 
Player, access the download at 
www.microsoft.com.

Windows Media export compatibility is 
subject to Microsoft Windows Media 
updates.

NVIDIA Driver 
Support

v275.89 See Setting up the NVIDIA Card.
For setting up the driver for stereoscopic, 
see the NVIDIA setup info in the 
Stereoscopic 3D Workflow Guide.

Shared Storage 
Support

Avid Unity™ MediaNetwork and 
Avid Unity ISIS®.

See “Shared Storage Support” on 
page 23.

Sony XDCAM 
driver

v2.12 (XDCAM Transfer for 
Macintosh)

Win 7-64 FAM 2.3.2and VFAM 
2.3.2

Avid recommends you install the VFAM 
3.0 (Macintosh OS) when using the 
PDWU1 device. The firmware version is 
2.45. The driver can be downloaded from 
Sony's website http://esupport.sony.com/.

Panasonic P2 drive (Macintosh) No device support 
for Lion

(Windows 7) Driver version for 
P2 devices:v2.16

There is currently no P2 writeback 
support for Macintosh clients.

Avid FX v6.0 Ships with:
Avid Media Composer
Avid Symphony 

Avid Artist Series 
(Euphonix)

EuControl software v2.5.7 or later See the User’s Guide for information on 
Artist Series Color setup information.

http://www.microsoft.com/en/us/default.aspx
http://esupport.sony.com/
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Avid Editing Application Compatibility with 
Pro Tools

General Co-Installation Notes:

• Install Pro Tools first and then Media Composer.

• You must uninstall all older versions of Media Composer or Pro Tools before installing 
newer versions.

• Co-install does not support both applications launched simultaneously.

• When you uninstall Pro Tools, choose to uninstall just the application and not the audio 
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 
system, this is named the “Safe Uninstall.” On a Windows Pro Tools system, you must select 
the first uninstall option — “Pro Tools Only” — which is not selected by default.

• (Macintosh only) When you uninstall your Avid editing application, you must uninstall just 
the application and not the audio drivers or Pro Tools no longer sees the devices. When you 
start the Avid Uninstaller, deselect the options to uninstall AvidCoreRuntime.pkg and 
AvidDIORuntime.pkg.

• Mojo SDI will not be supported with Media Composer, but can still be connected in a 
co-install configuration for use with Pro Tools.

• If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the 
editing application does not use any connected Pro Tools audio device for audio input/output 
operations. You can also use these audio devices with a software-only version of your Avid 
editing application (Media Composer and NewsCutter).

• If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then 
reinstall your editing application.

• Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the 
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x 
and Pro Tools v8.0.1 instead.

• If you want to install your Avid editing application on a system with the Pro Tools Avid 
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.
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Co-installation Configurations and Audio Device 
Support

Avid Pro Tools Applications

Avid Mbox Family Audio Devices (3rd Generation)

Avid Mbox 2 Family Audio Devices

Pro Tools 
Product

MC/NC 
Software 
Only

MC/NC 
with Mojo 
DX

MC/NC/
Symphony 
with Nitris DX

Pro Tools 
Software Only

Co-install Co-install Co-install

Pro Tools|HD 
Native

Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD, 
with chassis

Not Tested Not Tested Not Tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Mbox 
(USB)

Co-install/
Audio Device

Co-install Co-install

Mbox Pro Co-install/
Audio Device

Co-install Co-install

Mbox Mini 
(USB)

Co-install/
Audio Device

Co-install Co-install

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Mbox 2 
(USB)

Co-install/
Audio Device

Co-install Co-install
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Other Avid Audio Devices

External Controllers
Your Avid editing application supports the following external fader controllers or mixers for 
automation gain and pan recording or as control surfaces:

• Digi 002 (Windows only — Media Composer and NewsCutter)

• Command|8

• Avid Artist Control

• Avid Artist Mix

• Avid Artist Transport

Mbox 2 Pro 
(1394)

Co-install Co-install Co-install

Mbox 2 
Mini (USB)

Co-install/
Audio Device

Co-install Co-install

Mbox 2 
Micro 
(USB)

Co-install Co-install Not tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Digi 002 
(1394)

Co-install/
Audio Device 
(Windows)

Co-install Co-install

Digi 003 
(1394)

Co-install Co-install Co-install

Eleven Rack 
(USB)

Not Supported Not Supported Not Supported

Fast Track 
Pro (USB)

Audio Device Not Supported Not Supported
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• Avid Artist Color

• JL Cooper MCS-3000X MIDI automation controller

• JL Cooper FaderMaster Pro MIDI automation controller

• Yamaha® 01V/96 and Yamaha 01V digital mixing console

n The JL Cooper controllers and Yamaha mixing consoles do not support automation pan 
recording.

External controllers or mixers are optional. They are not required for you to perform automation 
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Feature
Digi 002 
(MC/NC only) Command|8

Avid Artist 
Control

Avid Artist 
Mix

Avid Artist 
Transport

Avid Artist 
Color

Control surface 
for transport 
controls and 
other functions

Yes Yes Yes Yes 
(transport 
only, no soft 
keys)

Yes

Provides audio 
play, input, and 
output

Yes No No No No

Record 
automation gain

Yes Yes Yes Yes No

Record 
automation pan

Yes Yes Yes Yes No

Flying faders Yes (8) Yes (8) Yes (4) Yes (8) No

Touch-sensitive 
faders

Yes Yes Yes Yes No

Touch-sensitive 
panners

No No Yes Yes No

Solo/mute Yes Yes Yes Yes No

Supports audio 
mixing

Noa No No No No

Latch mode 
(also known as 
Snap mode)

Yes Yes Yes Yes No
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The following table compares supported third-party external controllers and mixers.

For more information on using these external fader controllers or mixers, see “Recording 
Automation Gain or Automation Pan Information” in the Help.

Number of 
steps of fader 
accuracy

1024 1024 1024 1024 Not applicable

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or 
automation pan controller or control surface.

Feature
Digi 002 
(MC/NC only) Command|8

Avid Artist 
Control

Avid Artist 
Mix

Avid Artist 
Transport

Avid Artist 
Color

Feature FaderMaster Pro MCS-3000X Yamaha 01V/96 and Yamaha 01V

Control surface for transport 
controls and other functions

No No No

Provides audio play, input, and 
output

No No No

Record automation gain Yes Yes Yes

Record automation pan No No No

Flying faders No Yes Yes

Touch-sensitive faders No Yes No

Solo/mute Yes Yes Yesa

a. For Yamaha fader/controllers, solo works only if you do not use the unit for audio mixing at the same time

Supports audio mixing No No Yes

Latch mode (also known as 
Snap mode)

No Yes No

Number of fader steps of 
accuracy

128 1024 256
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Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version 
(install the display driver if necessary, and set the correct display settings. This version of the 
editing application requires the following Nvidia Driver:v275.89 

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver 
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities folder 
that installs with your Avid application.
Installation files for these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows 
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare 
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \ Utilities \nVidia and double-click the folder that 
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.

To set Desktop Video Editing Mode:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the menu bar, select Desktop. Enable Desktop>Video Editing Mode.

3. Click Apply.

To set the Prefer Maximum Performance mode and Global Settings:

1. Right-click the Desktop, and select Nvidia Control Panel.

2. Click Manage 3D Settings.

3. Set Global presets to Base profile. 
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4. In the Global Settings tab, change Power Management mode to Prefer Maximum 
Performance.

5. Click Apply.

6. Set the Global preset to 3D App-Video Editing.

7. Click Apply.

Reboot after installing the Nvidia software even if you are not prompted to do so. 
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must 
match the rest of the components the Nvidia installer installs.

Shared Storage Support

The editing application has been tested in a shared storage environment with the following. Note 
that ISIS 7000 was previously referred to as Avid Unity ISIS.

There is no support for ethernet attached clients in a MediaNetwork environment.

Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might 
experience problems if you are working on an older system. The following chart shows the 
hardware that Avid has successfully qualified when using these features. 

Editing 
Application 
Operating 
System

ISIS 
5000 
Client

ISIS 
5000 
Server

ISIS 7000 
Client

ISIS 7000 
Server

Media-
Network 
Client

Media-
Network 
Server

Windows 7 64-bit  v3.5 v3.2 v3.5 v2.2.2, v2.3, 
v2.4

v5.4 v5.1.3

Macintosh Lion 
v10.7.1, v10.7.2

v3.5 v3.2  v3.5 v2.2.2, v2.3, 
v2.4

v5.5  v5.1.3
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Feature Description Recommended System

Stereoscopic 3D For optimal performance with 
Stereoscopic 3D, use these higher 
performance systems. Avid 
recommends a minimum of 12GB 
RAM when using Stereoscopic 
3D.

• HP z800 Dual Quad Core, or 
Dual 6 Core, with 
Hyperthreading On

• HP z400, 6-core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual 6 Core 
“Westmere”

XDCAM HD50 Capture Baseband capture through Nitris 
DX, Mojo DX

• HP z800 Dual Quad Core, or 
Dual 6 Core, with 
Hyperthreading On

• HP z400, 6-core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual Quad Core 
“Nahalem” or Dual 6 Core 
“Westmere”

HD RGB HD RGB capture requires a high 
end workstation with Nitris DX 
and fast storage. (The HP z800 
and the Dell T5500 have been 
qualified to successfully play 
back 2 streams with PIP and 
Color Correction effects. The Mac 
Pro Dual Quad Core “Nahalem” 
successfully plays back 2 streams 
with PIP.)

• HP z800 Dual Quad Core, or 
Dual 6 Core, with 
Hyperthreading On - 64-bit OS

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 
64-bit OS

• Mac Pro Dual Quad Core 
“Nahalem” or Dual 6 Core 
“Westmere”

• Storage: 10Gb Ethernet ISIS, 
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AMA (RED) AMA is a processor intensive 
operation. Older platforms may 
not offer optimum performance.

• HP z800 Dual Quad Core, or 
Dual 6 Core, with 
Hyperthreading On

• HP z400, single 4-core or 6-core 
with Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual Quad Core 
“Nahalem” or Dual 6 Core 
“Westmere”

AMA (QuickTime) AMA is a processor intensive 
operation. Lower end platforms 
may not offer optimum 
performance. Highly compressed 
codecs such as H.264 will exhibit 
minimal real-time performance. 

Recommendation of qualified 
systems depends on your planned 
use of this feature. Heavy usage of 
highly compressed codecs requires 
the high end systems. 

Ancillary Data Ancillary Data and Nitris DX: 
Due to software DNxHD codec 
performance requirements, you 
must have a dual quad core 
system in order to capture 
DNxHD 220 or 220x with 
ancillary data on the Nitris DX 
platform. If your system does not 
meet the system requirements, the 
only way to capture DNxHD 220 
or 220x is to make sure that 
ancillary data is not enabled. 

Dual Quad Core or dual 6-core 
Systems

DVCPro HD capture You will get better performance 
with a dual quad core or dual 
6-core system.

Dual Quad Core or dual 6-core 
Systems

Feature Description Recommended System
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AVCI-Intra AVC-Intra(AVC-I) is a high 
quality, low bit-rate HD codec and 
is very CPU intensive. 

4-Way MultiCam Playback

• HP z800 Dual Quad Core or 
Dual 6 Core, with 
Hyperthreading On - 64-bit OS

• Mac Pro Dual Quad Core 
“Nahalem” or Dual 6 Core 
“Westmere”

Four Stream Playback:

• HP z800 Dual 6 Core with 
Hyperthreading On - 64-bit OS

• Mac Pro Dual 6 Core 
“Westmere”

Two Stream Playback:

• HP z400, single 6 Core with 
Hyperthreading On

Single Stream Playback:

• Systems listed above.

• HP z400, single 4-core with 
Hyperthreading On

• HP 8600, dual 4-core without 
Hyperthreading On

• HP 8740w laptop, i7 (1.73GHz) 
4-core with Hyperthreading On 

• HP 8540w laptop, i7 (1.73GHz) 
4-core with Hyperthreading On 

• Dell Precision M6500 laptop, i7 
(2.00 GHz) 4-core with 
Hyperthreading On

• The MacBook Pro 17" laptop, i7 
(2.66 GHz) 2-core with 
Hyperthreading On

• iMac 27", i7 (2.8GHz) 4-core 
with Hyperthreading On

Feature Description Recommended System
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Limitations

The following limitations apply to the current version of the editing application.

Avid Artist Color

➤ Bug Number: UDevC00157064. Some soft keys do not light up when you use the Avid Artist 
Color with your Avid editing application, including the following:

• HSL Shift Layer: all soft keys

• HSL Bank 2 Shift Layer: all soft keys

• Curves: F8 and F9 soft keys

• Curves Shift: F1, F3, F6, and F9 soft keys

• Secondary: F2, F7, F8, and F9 soft keys

• Secondary Shift: all soft keys

The soft keys listed above function normally even when they do not light up.

➤ Bug Number: UDevC00158145. When you use the Artist Color controller to perform color 
corrections, the Avid editing application might show some degradation of performance when 
safe color warnings are displayed. If you turn on safe color warnings and then perform a color 
correction, you might notice that the movement of the cursor becomes uneven. 

Workaround:  If you experience slower or uneven performance, turn safe color warnings off 
before you perform your color corrections.

➤ Bug Number: UDevC00163957. Hue offset color wheels might not appear when you use Artist 
Color to enter Color Correction mode the first time after start your Avid editing application. Any 
parameter update will draw them.

Workaround:  When you make any change in a parameter in the Color Correction tool, the 
color wheels appear.

➤ Bug Number: UDevC00157413. Currently only the Master controls for the Hue Offset and the 
Controls tabs of the HSL Group in the Color Correction tool are mapped to controls on the Artist 
Color controller. Hue Offset and Control parameter controls for Shadow, Midtones, and 
Highlights, as well as the Luma curves are not mapped. You must use the Color Correction tool 
to adjust these controls.
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➤ Bug Number: UDevC00156948.  (The F2 soft key (Next HSL Subtab) does not function until 
after you apply a color correction to your footage. If you press F2 (Next HSL Subtab) on the 
Artist Color surface before you apply a color correction, you get a system beep and the subtab 
does not change.

➤ Bug Number: UDevC00157932. If you use the HSL shift control for trackballs, you might see 
the trackballs controlling the wrong monitor during shuttle. For example, if you press Shift and 
then use the right trackball to shuttle, and then move either the left or the center trackball, you 
might see the other trackballs now control the right monitor.

➤ Bug Number: UDevC00158145. You might notice slower or uneven performance when making 
color corrections with safe color warnings turned on.

Workaround:  Click one of the Actions buttons in the Safe Color Settings dialog box, and select 
Ignore to turn safe color warning off.

➤ Bug Number: UDevC00164772. When you first ope n the Color Correction tool, either with the 
Artist Color or with the mouse, incorrect color correction values might display in parameter 
fields. This problem is intermittent, and it does not occur after you change a parameter value.

Workaround:  Adjust any parameter. The correct values display in the Color Correction tool.

➤ Bug Number: UDevC00164954. (Macintosh only): The EuControl application does not open 
when you select Edit Settings in the Controller Settings dialog box. To configure your EUCON 
device, you must open the EuControl application by clicking the EUCON icon in the dock, and 
then selecting Window > EuControl Settings.

Compatibility

➤ Bug Number: UDevC00151588. You must have the MediaNetwork client installed on your 
system in order to play linked AMA clips from the MediaNetwork shared storage.

➤ Bug Number: . The Standalone Transfer Manager will be supported with this release, except for 
compatibility with Airspeed Classic and Open I/O devices.
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Effects

➤ Bug Number: . AVX 1 effects are no longer supported and will not be recognized in this latest 
version of Media Composer. Please contact the respective 3rd-party plug-in vendor for an AVX2 
64-bit version of any existing plug-in that you might have purchased. The following Avid AVX1 
effects will automatically be promoted to AVX2:

• Avid Pan & Zoom

• Region Stabilize

• RGB Keyer

When you load a previously-generated sequence containing one of these effects, they will 
automatically be promoted to new corresponding AVX2 effects. These effects will not be 
recognized by earlier versions of Media Composer.

➤ Modifying Pan Values in the Timeline: You can display different pan values in the Timeline for 
different audio tracks by clicking the Clip Gain/Pan button in the Track Control panel and 
selecting one of the pan value options. However, if you want to manipulate pan control points 
(either adding a keyframe or adjusting a keyframe), you must make sure all audio tracks display 
the same pan values. To do this, Alt+click the Clip Gain/Pan button in the Track Control panel 
for any audio track and select a pan value option.

Interplay

➤ Interplay v.2.5 support for native HD 23.976p and HD 24p formats now includes their associated 
proxy resolutions. For more information refer to the Avid Interplay Best Practices Guide.

➤ Bug Number: . (Interplay) Dynamic relink is not currently supported for media that requires 
pulldown. Therefore, you can only use it with clips where the media has been acquired at the 
native frame rate (without pulldown).

➤ Bug Number: . (Interplay) Pro Res formats can only be used by Avid editing applications that 
are in a non-Interplay environment. For any additional limitations regarding running an Avid 
editing application in an Interplay environment, see the Interplay ReadMe.

➤ Bug Number: UDevC00164931. (Avid Interplay and Windows 7) Can't locate Media Indexer 
on Avid editor after first install. After an initial installation of the editor and Interplay support 
software, the editing application may fail to locate the Media Indexer. This can happen if some of 
the Avid Service Framework services have not started correctly.
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Workaround:  Open the Workgroup Properties tool on the editor and check whether any of the 
services are not running. Restart any services as required. Then restart the Avid editing 
application again. You may have to do this the first few times that you start the editor. After a few 
times the services will begin starting automatically, even after a reboot.

Media Tool

➤ Bug Number: UDevC00164836. If the Media Tool window is set to Frame view, you might 
experience slow redraw issues when accessing large volumes of shared storage.

Output

➤ You cannot control down/cross conversion from the Video Output Tool when in TrueP mode for 
1080p projects or when you are in Stereoscopic mode.

Workaround:  When in stereoscopic mode or have True Progressive output set for 1080p 
projects, the down-convert and cross-convert options are not available. To output at a rate 
different than the project format, go to the Format tab and change the output project setting.

Play

➤ Bug Number: UDevC00164987. After editing for an extended period of time, using the 
keyboard arrow keys to single step through the sequence might skip frames or move in the wrong 
direction. 

Workaround:   Minimize and maximize the editing application or change focus to another 
application and then back to the editor.

➤ Bug Number: UDevC00153838. You might receive an “Exception: The sequence or one of its 
source elements is too long to be played” error if you have a sequence over 12 hours.

QuickTime

➤ Bug Number: UDevC00159820. QuickTime Reference movies are not supported by 
QuickTime Player X. They are still supported in QuickTime Player 7 on the Macintosh. They are 
also not supported in QuickTime version 7.6.9 on Windows.
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Stereoscopic 3D

➤ A software developer's kit is now available for 3rd-party partners who would like to build AMA 
plug-ins, AVX2 effects, or develop applications that support stereoscopic 3D media/sequences 
compatible with Avid Media Composer or Symphony. This developer's kit is available on the 
Avid website.

➤ 720p Stereoscopic projects are not currently supported with Open I/O hardware from 3rd-party 
vendors.

➤ Bug Number: UDevC00164741. If a rolling title is used in an Over\Under stereo project, you 
may get the wrong scaling and cropping of lines.

➤ Stereoscopic projects are not supported on Avid Interplay.

➤ Multicam of stereoscopic clips is not supported.

➤ NVIDIA 3D Vision

• Avid currently only supports the NVIDIA 3D Vision Home bundle (which includes the 3D 
glasses, emitter hub and display monitor). The 3D Vision Pro has not been successfully 
tested.

• Full screen playback on an NVIDIA 3D Vision monitor is only supported on a Windows 
system. 

• Due to an NVIDIA driver issue, the first time that the full screen play window appears, the 
application will resize to a single monitor. Resize the application as necessary. You can reset 
your window positions by clicking on a toolset in the menu.

➤ Bug Number: UDevC00161499. Ancillary data output is not supported if you are working in 
full stereoscopic format.

Timeline

➤ Bug Number: UDevC00164751. If you have a sequence loaded in the Timeline, and you have 
waveforms on, clicking or dragging in the Timeline does not stop the waveform from drawing. 

Workaround:  Hold Cmd + . to stop the waveform from drawing.
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User Interface

➤ Bug Number: UDevC00162819. You cannot copy and paste timecode values into the Source or 
Record monitors. To enter timecode in the monitors, select the monitor and then type in the 
appropriate timecode values.

➤ Bug Number: UDevC00164678. You can drag audio keyframes past adjacent audio keyframes. 
Moving an audio keyframe past another keyframe causes the keyframes to swap values. For 
example, set volume levels on two audio keyframes: Keyframe A for low volume (left keyframe) 
and Keyframe B for high volume (right keyframe). If you then drag Keyframe A to the right of 
Keyframe B, Keyframe A now displays the higher volume level.

➤ Bug Number: UDevC00164360. Open bins with a large number of media objects do not remain 
open after quitting and then restarting the Avid editing application. This affects bins with over 
500 media objects. If you leave a large bin open and then quit the application, when you restart 
the application the bin is closed. 

➤ Bug Number: UDevC00164995. (Macintosh only) If you load a group clip into the Source 
monitor while in MultiCamera mode, the monitor displays the clip as if MultiCamera mode is 
still selected, although the action of loading the group clip actually causes the Avid editing 
application to enter Source/Record mode. If you play back the clip, you only see the linecut and 
cannot perform MultiCamera edits.

Workaround:  To turn off the Multicamera mode display, select Special > Multicamera Mode, 
and make sure MultiCamera Mode is not selected.

➤ Bug Number: UDevC00165159. (Macintosh only) If you render a sequence containing a title 
by selecting Clip > Render In/Out or by right-clicking the sequence and selecting Render In/Out, 
the progress bar displaying the status of the render operation does not update and the application 
appears to become unresponsive. However, even though the progress bar does not advance, the 
rendering operation continues. When it completes, the progress bar closes.
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Documentation Changes

The following changes have occurred since the documentation was completed:

Making an Audio Track the Primary Active Track

To make a track the primary active track, Alt+click the Audio Track Monitor button for the 
selected track.

Interoperability Enhancements with Avid Interplay

Interplay v2.5 supports the following features in the Avid video editing applications:

• Media Composer v6.0, Symphony v6.0 and NewsCutter v10.0 64-bit applications (64-bit 
Framework and 64-bit Media Indexer must be installed)

• End-to-end workflow for clips and sequences that include surround-sound audio tracks.

• Clips and sequences that use DNxHD444 RGB media. You can check clips and sequences in 
and out of the Interplay database and manage them as Avid assets.

For more details, refer to the Avid Interplay What's New in Version 2.5.

Opening and Closing Bins

To open several bins at once from the Project window:

1. Click a Bin icon in the Bins list.

2. Ctrl+click (Windows) or Command+click (Macintosh) each additional bin you want to 
open.

3. Do one of the following:

t To open each bin in a separate window, select File > Open Selected Bins.

t To open all bins as tabs in a single bin, select File > Open Selected Bins In One Window.

The selected bins open either in separate windows or in a single window with tabs indicating 
the bins.

n You can also open multiple bins by dragging them from the Bins tab in the Project window to an 
open bin. The bins open as tabs in the existing bin.
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Assigning a Workspace or Bin Layout Button

When you assign a workspace or bin layout to a button, the button displays the first two 
characters of the workspace or layout name. If the assigned workspace or layout is not 
available — for example, if you deleted the workspace or the bin layout — the button remains 
visible but the label displays italicized characters.

Deck Preferences Setting

There is an additional option in the Deck Preferences Setting to “Relax coincidence point 
detection.” This option is off by default. Depending on the deck, device control hardware or 
system you are using, marking an In point in the Capture Tool and performing a capture can 
result in a “coincidence point detection error.” If you select this option, the editing application is 
less strict on finding the coincidence point. Note, relaxing the detection can allow captures to 
succeed but has a greater possibility of capturing from the wrong in-point.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
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Trademarks
003, 192 Digital I/O, 192XD I/O, 888 I/O, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, ALEX, Alienbrain, AniMatte, AudioMarket, 
AudioPages, AudioSuite, AudioVision, AutoSync, Avid, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, 
Avid DS Assist Station, Avid EditStar, Avid Learning Excellerator, Avid Liquid, Avid Liquid Chrome Xe, Avid MEDIArray, Avid Mojo, 
AvidNet, AvidNetwork, Avid NewStar, Avid Remote Response, AVIDstripe, Avid Unity, Avid Unity ISIS, Avid VideoRAID, 
Avid Xpress, AVoption, AVX, Beauty Without The Bandwidth, Boom, C|24, CaptureManager, ChromaCurve, ChromaWheel, 
Command|24, Conectiv, CountDown, DAE, Dazzle, Dazzle Digital Video Creator, Deko, DekoCast, D-Fi, D-fx, DigiDelivery, 
Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, DigiDrive, DigiLink, DigiMeter, DigiSerial, DigiStudio, 
DigiStudio Control, Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, do more, DVD Complete, D-Verb, Eleven, 
Equinox, EveryPhase, ExpertRender, Fastbreak, Fast Track, FieldPak, Film Composer, FilmScribe, Flexevent, FluidMotion, FXDeko, 
G7, G-Rack, HD Core, HD Process, HDPack, HYBRID, HyperControl, HyperSPACE, HyperSPACE HDCAM, IllusionFX, 
Image Independence, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, Intelli-sat Broadcasting Recording Manager, 
Intelli-Sat, InterFX, Interplay, inTONE, Intraframe, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus, 
Lightning, ListSync, Lo-Fi, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, M-Audio, M-Audio Micro, 
Maxim, Mbox, MCXpress, Media Browse, Media Composer, MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, 
MediaLog, Media Reader, Media Recorder, MEDIArray, MediaShare, MediaStream, Media Suite, Meridien, MetaFuze, MetaSync, 
MicroTrack, Midiman, MissionControl, Mix Rack, MixLab, Moviebox, Moviestar, NaturalMatch, Nearchive, NetReview, NewsCutter, 
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Nitris, NRV-10 interFX, Octane, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, Open Media Management, 
Palladium, Pinnacle, Pinnacle DistanTV, Pinnacle Geniebox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile Media, 
Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, ProEncode, ProServices, ProSessions, Pro Tools, QuietDrive, 
Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, RetroLoop, rS9, rS18, Salesview, Sci-Fi, Scorch, Scorefitter, 
ScriptSync, SecureProductionEnvironment, Session, Show Center, Sibelius, SIDON, Soft SampleCell, Soft-Clip Limiter, 
Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, Sputnik, Starplay, SteadyGlide, Streamfactory, Streamgenie, 
StreamRAID, Strike, Structure, Studiophile, SubCap, Sundance Digital, Sundance, Symphony, SYNC HD, SynchroScience, 
SynchroScope, Syntax, TDM FlexCable, Thunder, Titan, Titansync, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, 
TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, Torq, Torq Xponent, Transfuser, Trigger Finger, Trillium 
Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Venom, VideoRAID, Video Slave Driver, VideoSPACE, VideoSpin, Vortx, Xdeck, 
X-Form, Xmon, Xponent, and X-Session are either registered trademarks or trademarks of Avid Technology, Inc. in the United 
States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or 
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows 
is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other 
trademarks contained herein are the property of their respective owners. 

Avid Media Composer, NewsCutter, and Symphony ReadMe • Part Number 0130-30387-02B • 1/4/12


	Title Page

	Symbols and Conventions
	If You Need Help
	Fixed in Media Composer v6.0.1, Symphony v6.0.1, and NewsCutter v10.0.1
	New in Media Composer v6.0, Symphony v6.0, and NewsCutter v10.0
	AMA Plug-ins

	Before Installing the Editing Application
	Notes on MacIntosh Snow Leopard OS
	Notes on Windows 7 OS
	Disabling Desktop Compositing
	Standard User

	Notes on Software Licensing
	If You Upgrade Your Operating System

	Minimum RAM Recommendation
	Qualified Hardware and Operating Systems
	Lion Permission Information
	Qualified PC Workstations with Avid Media Composer, Avid Symphony, and Avid NewsCutter
	Qualified PC Notebooks for Avid Media Composer, Avid Symphony, and Avid NewsCutter
	Qualified Macintosh Workstations for Avid Media Composer and Avid Symphony
	Qualified Macintosh Notebooks for Media Composer and Avid Symphony

	Compatibility Chart
	Avid Editing Application Compatibility with Pro Tools
	Co-installation Configurations and Audio Device Support
	External Controllers
	Setting up the NVIDIA Card
	Shared Storage Support
	Feature Performance
	Limitations
	Avid Artist Color
	Compatibility
	Effects
	Interplay
	Media Tool
	Output
	Play
	QuickTime
	Stereoscopic 3D
	Timeline
	User Interface

	Documentation Changes
	Making an Audio Track the Primary Active Track
	Interoperability Enhancements with Avid Interplay
	Opening and Closing Bins
	Assigning a Workspace or Bin Layout Button
	Deck Preferences Setting


